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Statement of Limited Warranty

This limited warranty gives you specific legal rights; you may also have other
rights which vary from state to state.

This limited warranty is extended only to the original purchaser of the Forvus
Emulator and is valid only with respect to purchasers within the United States
of America. Subject to the following conditions, should this product prove
defective by reason of improper workmanship or material:

• During a period of (90) ninety days from the date of original purchase,
Forvus Research, Inc. will repair or, at its option, replace the product
without charge for parts or labor.

This limited warranty does not apply (a) to any product damaged by accident,
misuse, disaster, including water, wind, fire and lightning, transportation,
vandalism or burglary, (b) if the product is altered or repaired by anyone other
than Forvus Research, Inc. or one of its authorized warranty repair stations.

Forvus Research, Inc.’s entire liability and your exclusive remedy shall be such
repair or replacement as is hereinabove provided. In no event will Forvus
Research, Inc. be liable to you or your customers for any damages, including any
lost profit, lost savings or other incidental or consequential damages arising out
of the use of or inability to use this product.

Some states do not allow limitations on how long an implied warranty lasts or
the exclusion or limitation of incidental or consequential damages, so the above
limitations or exclusions may not apply to you.

You may be required to provide a dated proof of purchase of this product in order
to obtain warranty service. If you have any questions regarding warranty service,
contact your point of purchase, or call Forvus Research, Inc. at (919) 954-8380.

Forvus Research, Inc. reserves the right to discontinue products and to change
specifications at any time without incurring any obligation to incorporate new
features in products previously sold.
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Introduction 

Thank you for purchasing the FORVUS Emulator!

The FORVUS Emulator provides an excellent emulation of the 3472 display
terminal including application defined screen formats, host addressable
print, and extended vital product data. The FORVUS Emulator is also
downward compatible with the older 3192, 3180, and 3278/79 terminals.

Some of the advanced features of  the FORVUS Emulator include:
• Supports attachment to Novell Netware for SAA Version 1.2 or higher.
• Supports DFT and CUT Coaxial interfaces.
• Supports synchronous modem connection with IBM SDLC compatible

communication adapter.
• Supports attachment with 802.2 and TN3270 interface.
• Online screen setup - makes it possible to change display characteristics

without exiting the program.
• Supports 3472 Partitions - allows more than 7600 characters to reside

inside the display in a single session, and allows application programs
to change screen formats as needed. 

• Host Addressable Print - allows host to send messages to a locally
attached printer without operator intervention.

• Print Trim - allows operator to print a selected portion of the screen to
a locally attached printer, saves time and paper.

• Record/Playback - Easily save often used keystroke sequences for later
playback. 

• Selector Pen emulation - Use an attached Mouse to point and select data
quickly - without the use of your keyboard.

• File Transfer - allows transfer of files to and from the host application
using IND$FILE and PCXFER.

• Pop-Up Keypad - Activate keystrokes with a single mouse click,
including Program Function keys.
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System requirements
The FORVUS Emulator is designed to work with the following communica-
tions interfaces:

• Novell NetWare for SAA Version 1.2 or higher. 
• IBM SDLC Communications Adapter
• Forvus Research Coax Adapter
• IBM or IRMA Compatible Coax Adapter
• 802.2 Network Interface
• TCP/IP Interface

In addition to the Communications interfaces, your PC must be equipped
with the following features:

• Windows-capable 386 or higher personal computer.
• EGA or VGA (recommended)
• Microsoft Windows Version 3.1 or higher.
• Microsoft Windows-compatible pointing device.
• Either PC-DOS or MS-DOS operating system, Version 3.3 or higher.
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Manual organization

The following sections of this manual will provide you with the information
you will need to install and operate the FORVUS Emulator.

• Installation and Setup
• Operation
• Status Row Information
• Problem Determination
• File Transfer
• Error Messages
• Keyboard Templates

README.DOC
Should your Diskettes contain the file README.DOC, it contains important
information that was not available when this manual went to press. Please
review this file before beginning the installation process.
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Product support
If you have a question that isn’t answered in this manual, our Product
Support Department can help. Free telephone support is provided for 90
days to you as a new user when you return the enclosed registration card.
Many questions can be answered in this manual. However, if you’ve checked
your manual and still need assistance, please have your computer powered
on and the following information available:

• your name and address
• your FORVUS Emulator software serial number
• your computer make and model, the amount of RAM installed, the type

and capacity of your hard disk and floppy drives, the display adapter and
monitor type, printer name and model number

• Version number of Novell NetWare for SAA (if applicable)
• Type of coaxial adapter installed (if applicable)
• 802.2 interface adapter manufacturer (if applicable)
• TCP/IP vendor stack (if applicable)
• Windows version
• DOS version number (if applicable)
• contents of your CONFIG.SYS and AUTOEXEC.BAT files
• a clear description of your problem

Call Product Support at (919) 954-8380 between 9 a.m. and 5 p.m. EST
(excluding US holidays). We will be happy to assist you.

We may also be contacted via the Internet at: http://www.forvus.com
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Installation and Setup
This section will guide you through the steps necessary to install the
FORVUS Emulator and to set up the many available options. Please take a
moment to read these steps before you begin your product installation.

Before You Begin . . .

Forvus Research, Inc. is confident you will find that this software will
increase your productivity. So that we can continue to provide you with
technical support, and keep you informed about new software developments,
please return the enclosed product registration card supplied with this
package.

Network Considerations
The FORVUS Emulator can be installed on a file server and accessed by
multiple users from their independent workstations. Please refer to your
Software License Agreement to determine if this product is a network
capable version.

+

Refer to page 35 to complete the installation for each user’s workstation.

Before installation on a file server, you must log onto the server as
the system administrator to ensure that full read/write and file
attribute changing rights are available for the drive on which the
emulator is to be installed.
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Setting Up the FORVUS Emulator
You use the Setup program to set up the FORVUS Emulator. Setup checks
your system and asks a series of questions about how you want to install the
emulator.

To set up the FORVUS Emulator:

1. Start Microsoft Windows.

2. Insert Setup Disk 1 into the appropriate floppy drive.

3: (Windows 3.1 users) From the File menu in Program Manager, choose
Run...
  (Windows 95 users) Click the Start button from the taskbar, and then
click Run...

4. Type f:setup in the Command Line box (where f: is replaced with the
letter of the drive in which the disk was inserted) and choose Ok.

5: Follow the setup instructions on the screen.
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Configuring the FORVUS Emulator
Before you will be able to start communication with the host, you must
customize the FORVUS Emulator for use with your particular application.
The Configuration program is used to assign such features as the type of
keyboard you wish to emulate, screen size, menu language, communications
interface, etc.

The following panel will appear:

+

To set the various configuration options, move the mouse cursor to the menu
item Options and double-click. A drop-down menu will appear and allow you
to set various options described in the sections that follow.

First Time Installation: Upon installing the emulator for the first
time, the Configure Communications dialog box will appear.
Refer to Page 26 to configure your host connection parameters.

Figure 2-1. Configuration Sign-on panel.
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Changing the Language Setup

To setup the language for the various messages the emulator provides
(on-line help, message boxes, dialog boxes, etc) follow the steps below:

• Choose Options from the main menu.
• Select Language Setup.
• Select the desired language to the right of the language setup option (as

shown in Figure 2-2 below)

Configuring the 3270 Session
To customize the session parameters, follow the steps below:

• Choose Options from the main menu.
• Select Session Configuration . . .

You will be prompted to select the configuration file you wish to modify as
shown below:

Figure 2-2. Options menu.

Figure 2-3. Load Configuration dialog box.
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After making your selection, the following dialog box will appear:

Mod Size

This selection sets the number of rows and columns the 3270 screen displays
while attached to the host session. Select between 24x80, 32x80, 43x80 or
27x132.

Keyboard

The keyboard options are listed below:
• Size - Informs the FORVUS Emulator of the size of the PC keyboard.
• Type - Informs the FORVUS Emulator of the type 3270 keyboard

emulation to perform.
• Language file - The keyboard language file defines the keyboard key

functions. You can modify an existing keyboard file or create a new one,
as described in "Configuring the Keyboard" on Page 14. Refer to
Appendix C, "Keyboard Layouts" to reference the style layout you prefer.

• Pop-up keypad file - defines the pop-up keypad key functions. You can
modify an existing pop-up keypad file or create a new one, as described
in "Configuring the Pop-Up Keypad" on Page 18.

• Hotspot file - The Hotspot file defines the screen hotspots. You can
modify an existing hotspot file or create a new one, as described in
"Configuring Hotspots" on Page 21.

Figure 2-4. Session Configuration dialog box.
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• Numeric Lock - Restricts the characters that can be keyed into a numeric
field.

Feature Options

The session feature options are listed below:
• Partition/CECP - When this check box is enabled, the CECP (Country

Extended Code Page) and scrolling feature is active when attached to
the control unit. This function is under complete control of the host
application.

• Host Addressable Print - When this check box is enabled, the host
addressable print feature is activated. Also the Configure Print . . .
pushbutton is activated which enables the operator to set print options
for the host addressable print feature.

When the Configure Print . . .  pushbutton is pressed, the following
dialog box will appear:

Printer type

Select the type of printer to direct the host addressable print.

Figure 2-5. Host Addressable Print Options dialog box.
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Printer port

This selection is used to direct the printer output to the hardware port. Select
either a serial or parallel printer using the choices given in the list box.

Chars/Inch

This selection allows you to set the host addressable print Characters per
Inch. Select between Default, 10, 12, or 17 CPI. The Default selection uses
the printer’s default settings.

Lines/Inch

This selection allows you to set the host addressable print Lines per Inch.
Select between Default, 3, 4, 6, or 8 LPI. The Default selection uses the
printer’s default settings.

Lines/Page

This selection allows you to set the host addressable print Lines per Page.
Select between Default 51, 60, 66, 68, 72, 88, or 96 LPP. The Default
selection uses the printer’s default settings.

Wide Paper

If the attached host addressable printer supports a wide carriage, selecting
this option enables the printer to utilize the full length of the paper.

Suppress Line Feed when:

These options can suppress an automatic line feed when the following events
are encountered:

• CR at maximum print position + 1 - Deselecting this option will
activate any carriage return in the last print position + 1 in addition to
the automatic line feed. Selecting this option will permit the action of
the carriage return only.

• FF at print end - Deselecting this option will activate any form feed
included at the end of the print job in addition to the automatic line feed.
Selecting this option will permit the action of the form feed only.

• NL at maximum print position + 1 - Deselecting this option will
activate a new line command included in the last print position + 1 in
addition to the automatic line feed. Selecting this option will permit the
action of the new line command only.
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Form Feed

These options will affect the way the Forms Feed character is handled when
encountered in a data stream:

• Ignored when not in first print position - Select this option if you
want any form feed command to be ignored unless it appears in the first
print position of any line. Deselecting this option will cause all form feed
commands to be executed.

• Takes position if followed by data - Select this option if you want
form feed commands not located at the end of the print job to cause a
form feed to be executed and to insert a blank character in the first
position to the next page. Deselect this option if you want printing to
begin in the first position of the next page after the form feed.

• At end of print - Select this option if you want the printer to eject the
last printed page. This positions the next print job on the next page.
Deselect this option if you do not want to eject the last printed page.

Quality

If the attached printer supports NLQ (Near Letter Quality), you can select
either NLQ or Draft.

Print Options

The following options are offered to modify the format of the data stream
received by the printer:

• Print with Attributes - Selecting this option enables you to print with
bold and underline attributes. Deselecting this option will increase print
speed by printing the data with no attributes.

• Default to 17 CPI - Selecting this option enables you to set the print
to 10 or 12 CPI for Mod 2, Mod 3, and Mod 4 prints and to change
automatically to 17 CPI when a Mod 5 print occurs. After the Mod 5
print, the CPI selection returns to its normal setting. Deselecting this
option will default to the normal CPI settings.

• Suppress null lines - Selecting this option enables you to print more
data on the page by suppressing the printing of null (blank) lines.
Deselecting this option will default to normal printing.

• ASCII Transparency - This option determines how the 3287
Transparent Data Command is handled. Selecting this option passes
ASCII data directly to the selected printer.
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Adding a Session Icon

When using the FORVUS Emulator, it is possible to define multiple configu-
ration files and recall them from individual icons.

To add a session icon and assign it to an existing configuration file, follow
the steps below:

• Choose Options from the main menu.
• Select Add Session Icon . . . 

The dialog box shown in figure 2-6 will appear:

Label for Icon?

This entry will be the label for the new icon that will be added to the selected
group box. Enter the desired label and proceed to define the group box to
place the new icon.

Figure 2-6. Add Icon dialog box.
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Group box to add Icon to?

This entry will be the group box under the Program Manager that the new
icon will be added to. Enter the desired group box and proceed to define the
configuration file to assign the new icon to.

Configuration file to use?

This entry will assign the desired configuration file to the new icon. Select
the desired configuration file and press the Ok pushbutton to complete the
assignment.

Press the Cancel pushbutton to abort the above process.

Configuring the Keyboard

The FORVUS Emulator is capable of using many different types and layouts
of system unit keyboards. Although many different layouts of keyboards are
provided with the package, the user may wish to relocate various keys for
that "custom touch".

The emulator uses the .KBF file extension for its keyboard template con-
figuration files.

To begin the configuration process, follow the steps below:
• Choose Options from the main menu.
• Select Keyboard Configuration . . . 

A dialog box similar to the one shown below will appear:

Figure 2-7. Load Keyboard File dialog box.
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Select a file to modify from the list box on the left.  After you select the file
you wish to modify, press the Ok pushbutton to continue.

Pressing the Cancel pushbutton will exit the keyboard configuration, and
return you to the main configuration panel.

After pressing the Ok pushbutton, a dialog box similar to the one shown in
Figure 2-8 will appear:

File

This menu will allow you to save changes made to any keyboard configura-
tion file.

This selection will also allow you to exit the configuration program.

Figure 2-8. Keyboard Configuration dialog box.
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PC Keyboard Type

This menu contains the type of PC keyboard that you have attached to your
system unit. Selecting this menu will display the following drop-down menu:

Select the type of keyboard your system unit contains from the menu shown
above. After making your selection, a check mark will appear indicating your
choice. The corresponding key table will be displayed at the bottom of the
keyboard configuration dialog box.

Modifying a Key Sequence

To modify a key sequence, choose the PC key you wish to modify from the
"Select a PC key" list box at the bottom of the dialog box. In the example
below, the Apostrophe key has been selected.

Figure 2-9. PC Keyboard Type menu.

Figure 2-10. Apostrophe key example.
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Displayed at the top center of the dialog box is the current key functions
assigned to the Apostrophe key. The sequences are shown in the following
order:

• Normal key
• Shifted key
• Control key
• Alt key
• Alt and Control key

Located to the Left and Right of these sequences are the Add key (>>-->)
and Delete key (DEL) pushbuttons.

Deleting an Emulator Function

Pressing the appropriate Delete pushbutton will delete the 3270 keyboard
operation found under "Emulator Function".

Adding an Emulator Function

Pressing the appropriate Add (>>-->) pushbutton will add the 3270 key-
board operation selected in the "Select  Function" listbox found at the top
left corner of the dialog box.

To modify the key sequence for another PC key, select the desired key from
the "Select a PC key" listbox and repeat the above steps.

Saving the Modified Configuration File

After you have completed all modifications to the configuration file, be sure
to SAVE the file to disk. Follow the steps below to write the configuration
file to disk:

• Select File from the sub-menu found at the top of the dialog box.
• Enter the name of the new .KBF file you would like to save this

configuration under.

+ It is important to name the new keyboard configuration file
different than the original keyboard configuration filename
supplied with the emulator; future updates/upgrades may
overwrite the factory supplied file.
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Selecting the New Keyboard File for Use with a Session

To command the emulator to accept this new configuration, follow the steps
below:

• Choose Options from the main menu.
• Select Session Configuration . . 
• Select the name of the new .KBF file just saved from the "Pop-Up

Keyboard file:" list box.
• Press OK to exit the Session Configuration Dialog box.

Configuring the Pop-Up Keypad
The Pop-Up Keypad configuration will allow the user to customize the
on-screen pop-up keypad. This keypad is displayed when the Right mouse
button is pressed while the emulator window is active. The keypad actually
consists of two (2) keypads in one layout. Found at the bottom of the keypad
is the pushbutton labeled Next Keypad. Pressing this button when the
keypad is displayed will result in the display of the alternate keypad.

To begin the Pop-Up Keypad configuration, follow the steps below:
• Choose Options from the main menu.
• Select Pop-Up Keypad Configuration . . . 

A dialog box similar to the one shown in Figure 2-11 will appear:

Figure 2-11. Keyboard template file load dialog box.

18       FORVUS Emulator User’s Guide



• After selecting the Keyboard configuration file you will be using with
the Pop-Up Keypad, press the OK button to continue.

A dialog box similar to the one shown below will be displayed:

• Select the Pop-Up Keypad file you would like to modify. The keypad
configuration dialog box will appear as shown in Figure 2-13 on the
following page:

Figure 2-12. Popup keypad file load dialog box.
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Displayed at the top left of the dialog box is the actual layout of the keypad.
The keypad size controls are found at the top right of the dialog box. The
size controls are defined below:

• Rows - Determines the number of horizontal rows the keypad contains.
Modifying this number will allow you to add or delete rows of keys.

• Columns - Determines the number of vertical columns the keypad
contains. Modifying this number will allow you to add or delete columns
of keys.

• Width - Determines the number of character each key can contain. 

+

Assigning keys to the keypad

After configuring the format of the keypad, you may elect to assign keyboard
keys to each key on the keypad. To begin this procedure, follow the steps
below:

• Select a sequence from the "Select an Emulator Function" list box found

If you specify a number less than the width of the text placed
on the key, the full text may not be displayed on the key.

Figure 2-13. Popup Keypad Configuration dialog box.
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at the bottom left of the main dialog box.
• Click on the desired keypad key to place the selected function.

Saving the Modified Keypad File

To save the modified keypad file, follow the steps below:
• After configuring the desired keys on the keypad, select File from the

menu at the top of the window.
• Enter the name of the new .POP file you would like to save.

+

Selecting the New Keypad File for Use with a Session

To command the FORVUS Emulator to accept this new configuration, follow
the steps below:

•  Select Session Configuration . . . from the Options menu found under
the main title bar.

• Select the name of the new .POP file just saved from the "Pop-Up keypad
file:" list box.

• Press OK to exit the Session Configuration dialog box.

Configuring Hotspots

The Hotspot configuration will allow you to customize the hotspots that the
FORVUS Emulator recognizes while attached to the host.

Loading a Hotspot Configuration file

To begin the Hotspot configuration, follow the steps below:

• Choose Options from the main menu.
• Select Hotspot Configuration . . . 

A dialog box similar to the one shown in Figure 2-14 will appear:
 

It is important to name the new Pop-Up Keypad configuration file
different than the original configuration filename supplied with
the emulator; future updates/upgrades may overwrite the factory
supplied file.
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• After selecting the Keyboard configuration file you will be using with
the Hotspot configuration file, click the OK button to continue.

A dialog box as the one shown in Figure 2-15 will be displayed:

Figure 2-14. Keyboard template file load dialog box.

Figure 2-15. Loading a Hotspot File dialog box.
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• Select the Hotspot file you would like to modify. The hotspot
configuration dialog box will appear as shown below:

Adding a Hotspot

After loading the hotspot file as described in the preceding section, follow
the steps below to Add a hotspot:

• At the top right of the above dialog box you will see the edit control to
"Enter on Screen Text for New Hotspot". This will add the text that the
emulator will search for when the mouse is single clicked.

• Locate the "Select an Emulator Function for above Text" edit control.
In the list box located at the bottom right of the screen are the keyboard
functions that may be sent to the host when the new hotspot is found
on the display. Select the function for the new hotspot.

• Press the Add pushbutton to add the new hotspot.

Figure 2-16. Hotspot Configuration dialog box.
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Deleting a Hotspot

After loading the hotspot file as described in the preceding section, follow
the steps below to delete a hotspot:

• Select the hotspot you wish to delete on the left side of the display.
• Press the Delete pushbutton at the bottom left of the dialog box.

Saving a Hotspot configuration file

To save the modified hotspot file, follow the steps below:

• Select File from the menu at the top of the window.
• Enter the name of the new .HOT file you would like to save.

+

Selecting the New Hotspot File for Use with a Session

To command the FORVUS Emulator to accept this new configuration, follow
the steps below:

•  Select Session Configuration . . . from the Options menu found under
the main title bar.

• Select the name of the new .HOT file just saved from the "Hotspot file:"
list box.

• Press Ok to exit the Session Configuration dialog box.

VPD Serial Number
To display/change the VPD information, follow the steps below:

• Choose Options from the main menu.
• Select VPD Serial Number. . .

(if this selection is grayed, the communication driver you have selected
does not support the VPD feature)

It is important to name the new Hotspot configuration file
different than the original configuration filename supplied with
the emulator; future updates/upgrades may overwrite the factory
supplied file.
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A dialog box similar to the one below will be displayed:

When changing the nine digit serial number, only the characters uppercase
A-Z, 0-9 and the space character may be entered. If any other character is
entered, an error message will be displayed and you will be prompted to take
appropriate action.

+ The VPD serial number is saved to disk when the dialog box is
exited.

Figure 2-17. Vital Product Data dialog box.
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Communications Configuration

The Communications configuration option will allow you to customize the
individual sessions you will be using when attached to the host.

• Choose Options from the main menu.
• Select Configure Communications . . .

The following dialog box will appear:

Number of Sessions

(Not Used in CUT mode) Select the Number of Sessions that you will be
using while attached to the host. The number you select (1-8) will determine
how many individual sessions you will have to configure as explained below.

Language for Sessions

(Not Used in CUT mode) Select the language Code Page you will be using
with the host from the drop-down selection box.

Unsupported Control Codes

(Not Used in CUT mode) This selection will determine how unsupported
control codes will be handled.

Numeric Delimiter

(Not Used in CUT mode) Select either a period or a comma for a numeric
delimiter used during sessions.

Figure 2-18. Communications Configuration dialog box.
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Connection Type
To select the type of connection that the FORVUS Emulator will use when
communicating with the host you may select between DFT, CUT, SAA,
SDLC, 802.2 or TN3270. These connections are further described below:

CUT or DFT Connection

Select CUT or DFT from the Connection Type and press Configure . . .  
A dialog box similar to the one shown below will appear:

When your adapter selection been entered, press OK to return to the main
configuration panel.

SAA Connection

Before you begin, you must obtain the following information from your
system administrator:

• The number of sessions you will be using (up to 8)
• The Communications Server ID name
• The Service Profile
• Your User ID
• Your Password
• The LU type (Any, Public, Pooled, or Dedicated)
• LU Name (if required)

Figure 2-19. Adapter type dialog box.
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Select SAA from the Connection Type and press Configure . . .  
The following dialog box will appear:

Depending on the Number of Sessions you selected above, you will be
required to configure each session (A-H) as described below:

Comm Server

Enter the name of your communication server you wish this session to attach
to.

Service Profile

Enter the service profile you wish this session to obtain.

User ID on Comm Server

Enter your User ID for this session

Password on Comm Server

Enter your password for this session

LU

Select the LU type by selecting any one of the options (Any, Public, Pooled,
or Dedicated). If you select Pooled or Dedicated, you will have to provide the
LU Name in the Entry box.

Figure 2-20. SAA Configuration dialog box.
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When all selections have been entered, press OK to return to the main
configuration panel.

SDLC Connection

Before you begin, you must obtain the following information from your
system administrator:

• The Block ID
• The Physical Unit ID 
• Physical Unit Address
• RU Size
• NRZ/NRZI
• Switched/Unswitched Line

Select SDLC from the Connection Type and press Configure . . 
A dialog box will appear as shown below:

Block ID

The Block ID is used to inform the host of the type of SDLC connection.
Enter the three (3) hex digits you received from your system administrator.

Physical Unit ID

The Physical Unit ID is used to inform the host of the unit ID of the SDLC
connection. Enter the five (5) hex digits you received from your system
administrator.

Figure 2-21. SDLC Configuration dialog box.
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Physical Unit Address

The Physical Unit Address is the SDLC address that the FORVUS Emulator
uses on the line connection.

RU Size

The RU size is the maximum size that the FORVUS Emulator can receive
from the host.

Encoding

Select between NRZ or NRZI type line connection.

RTS

Select between Unswitched or Switched RTS (Request-to-Send).

Press Ok to return to the main configuration panel.

802.2 LLC Connection

Before you begin, you must obtain the following information from your
system administrator:

• The Block ID
• The Physical Unit ID 
• Node Address
• SAP
• RU Size
• Primary/Secondary Adapter

Select 802.2 LLC from the Connection Type and press the  Configure . .
pushbutton.

The following dialog box will appear as shown on the following page:
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Block ID

The Block ID is used to inform the host of the type of SDLC connection.
Enter the three (3) hex digits you received from your system administrator.

Physical Unit ID

The Physical Unit ID is used to inform the host of the unit ID of the SDLC
connection. Enter the five (5) hex digits you received from your system
administrator.

Node Address

The Node Address is the address of the Gateway that the emulator will be
using on the network.

SAP

The SAP (Service Access Point) for 802.2 is default 04.

RU Size

The RU size is the maximum size that can be received from the host.

Primary/Secondary Adapter

Select between either a primary or secondary network adapter connection.

Press Ok to return to the main configuration panel.

Figure 2-22. 802.2 LLC Configuration dialog box.
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TN3270 Connection

Before you begin, you must obtain the following information from your
system administrator:

• TCP/IP Stack
• Destination Host 
• Telnet Port

Select TN3270 from the Connection Type list and press the  Configure . .
pushbutton.

TCP/IP Stack

The TCP/IP Stack selection is used to inform the emulator of the Internet
Protocol stack you wish to attach to. Select the third party stack you have
installed on your system unit.

Destination Host

Enter the name or address of the Host you would like this session to attach
to.

Example:     143.238.693.021

Figure 2-23. TN3270 Configuration dialog box.
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Destination LU

When using the TN3287 option of TN3270, enter the destination LU Name
of the printer.

+

Telnet Port

Select the Telnet port address by selecting one of the options (Default or
User Defined). If you select User Defined, you will have to enter the four
decimal digits for the Telnet port address.

Example:    0023   (Default Telnet Port) 

Repeat this step for each session you will be using on the TN3270 connection.
(Session A, B, etc)

When all selections have been entered, press Ok to return to the main
configuration panel.

The Destination LU is not supported on all gateways. If this
function is not supported, then leave this field blank.
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Exiting the Configuration Program
After you have completed the Configuration program, Select Exit from the
Options menu bar to exit the Configuration program.

+

Your FORVUS Emulator is now ready to attach to your host system(s). Refer
to the next chapter "Operation" for more information on how to launch the
FORVUS Emulator.

Some selections require that you re-boot your system unit (e.g..
changing a communication driver). You will be notified should
this condition occur.
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Installing a workstation for use with a Network 
In order for workstations to start the FORVUS Emulator installed on a file
server, an icon must be created for each workstation.

Follow the steps below to complete the workstation installation:
• Create an environment variable that determines where the user’s

configuration is stored. The environment variable that the emulator
uses is 3270USER. 3270USER should be set to a directory where the
user has read/write access. This variable could be initialized in the users
Login Script, AUTOEXEC.BAT file or anywhere desired, but it must
be initialized before COMMDVR or the FORVUS Emulator is loaded.

Network login script example: (Preferred Method)
 SET 3270USER = "F:\USER\%Login_name\SAA" 

AUTOEXEC.BAT example:
 SET 3270USER=F:\USER\JOHN\SAA

The 3270USER variable must be set to a valid (already created)
directory.

• After initializing the 3270USER variable, execute COMMDVR.EXE.
(found in the emulator subdirectory)

• Start Microsoft Windows.
• (Windows 3.1) Under the File. . . menu, click Run. . . 

(Windows ’95) Click Start on the taskbar and click Run. . ..
• In the command line entry field, type

  f:\subdirectory\INIT_USR.EXE

where f:\subdirectory\ is replaced with the drive and subdirectory where
the FORVUS Emulator was installed.

•  Press the Ok button to start the user workstation installation program.
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After INIT_USR creates the Group Box, it loads the Configuration program.
Any changes made to the Configuration from this point are saved in the
directory specified by the 3270USER environment variable.

+ If an asterisk (*) is seen beside a session configuration file (.CNF),
it indicates that the file is located in the FORVUS Emulator directory
on the file server.

When installing an update/upgrade, all users must exit the FORVUS
Emulator and unload the communications driver
(COMMDVR.EXE) if loaded.

36       FORVUS Emulator User’s Guide



Operation
This chapter describes the basic operation of the FORVUS Emulator. Before
getting started make sure that:

• The FORVUS Emulator has been installed and configured for the type
of operation desired.

• All connections both inside and outside the system unit are securely
attached.

• The system unit Security Key lock (if equipped) is unlocked.
• Windows 3.1 or Windows ’95 is installed and operating on your system

unit.
• Necessary network drivers are loaded in memory. For example, IPX/SPX

must be loaded for use with SAA.

Starting the FORVUS Emulator

Windows 3.1

To start the FORVUS Emulator while running Windows 3.1, move the
mouse pointer to the small terminal icon and double-click the left mouse
button to begin program execution as shown below:

After initialization, you will be prompted to load a configuration file as shown

Figure 3-1. FORVUS Group Box.
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by the dialog box below:

Select the desired configuration file you wish the FORVUS Emulator to load
and press the Ok pushbutton. A session window will open and will attempt
to attach to the control unit.

Loading a Configuration File Automatically at Startup

You can command the FORVUS Emulator to automatically load a specified
configuration file when you start the program by following the steps below:

• Single click on the FORVUS icon.
• Single click on the Program Manager -  File menu.
• Select Properties. . . from the drop-down menu.
• Shown on the command line is f:\path\FORVUSW.EXE where f: is the

drive and \path is the directory where the FORVUS Emulator is
installed.

• Add <space>/S=filename.CNF where filename is the name of the
desired configuration file you want to automatically load at startup.

Example = C:\FORVUS\FORVUSW.EXE /S=DEF.CNF

Figure 3-2. Load Configuration dialog box.
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Windows ’95

To start the FORVUS Emulator while using Windows ’95, press the Start
button on the taskbar and then point to Programs. Moving the mouse to the
right, Point to the Forvus Folder and then to the FORVUS icon and click as
shown below:

Keyboard Operations
The FORVUS Emulator program uses a subset of the IBM 3472 keyboard.
In some cases, the FORVUS Emulator must use a different key location than
may be found on other types of display stations. Refer to Keyboard Help on
the emulator session drop-down Help menu to locate the key functions for
your keyboard layout.

Figure 3-3. Windows ’95 Start Example.
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Menu Bar Commands
The FORVUS Emulator contains a menu bar that resides under the window
title bar as shown below:

The menu bar contains the above commands that will be described in the
sections that follow.

Hiding/Displaying the Menu Bar

You may want to hide the menu bar to increase the size of the session
window. 

To hide the main menu bar select the Control-menu box in the upper-left
corner of the session window and select Hide Emulator Menu.

To show the main menu bar select the Control-menu box in the upper-left
corner of the session window and select Show Emulator Menu.

Enabling/Disabling the Menu Shortcut Keys

The main menu contains shortcut keys for each command found on the
menu. These keys are underlined on each command and may be used with
the ALT key to directly access the menu. However, the ALT key sequence
conflicts with some control units command sequences. Therefore, if the
shortcut keys are disabled, the control unit key sequences may be sent to
the control unit without conflict.

To Hide/Show the menu shortcut keys, select the Control-menu box in the
upper-left corner of the session window and select the appropriate command.

File Command
The File menu is used to manipulate certain file load and save procedures
used with the FORVUS Emulator. The following submenus are available
under the File menu:

◊ Load Configuration
To load a different configuration file, follow these steps:

• Select Load Configuration from the File drop-down menu.
• Select the configuration file you want to load from the Configuration file

item selector box, then click on the Ok pushbutton.
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◊ Save Configuration
To save the current configuration file,follow these steps:

• Select Save Configuration from the File drop-down menu.
• Enter the name for the configuration file in the entry box -or- make a

selection from the Configuration file listbox, then click on the Ok
pushbutton.

◊ File Transfer
This selection is used to initiate a File Transfer between the host application
and the FORVUS Emulator. Refer to "File Transfer" in Chapter 6 found later
in this manual.

◊ Printer Setup
This selection is identical to the printer setup found in the Setup drop down
menu. Refer to page 48 for more information on printer setup.

◊ Local Print
This selection is used to send an image of the screen to the locally attached
printer. Refer to "Print Function" on page 60 for more information on local
screen printing.

◊ Exit
This selection is used to exit the FORVUS Emulator.

Edit Command
The Edit menu is used to alter the session text displayed on the FORVUS
Emulator session window. Text may be transferred between different appli-
cations using the Windows clipboard function.

The following submenus are available under the Edit menu:

◊ Undo Cut
This command is used to replace text that was Cut in a previous operation.
The text that is replaced will be inserted in its original location on the
display.
 Note: If the Undo Cut selection is grayed, either the clipboard is empty,
or the text that was cut has been modified and can no longer be replaced on
the display.
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◊ Cut
This command is used to copy all data selected to the clipboard and remove
all unprotected data from the 3270 session display. The space occupied by
the unprotected data will be left blank on the display.

◊ Copy
This command is used to copy all data selected to the clipboard.

◊ Paste
This command is used to paste data from the clipboard to the position held
by the cursor.

◊ Select All
The Select All function is used to select all text displayed on the 3270 session.
This is useful when copying (or cutting) the complete session display to the
Windows clipboard.

Selecting data to be Cut or Copied to the Clipboard

To select text to be edited on the 3270 session display, follow the steps below:

• Using the mouse as a pointer, place the arrow at the top left or bottom
right of the text to be copied.

• Press the left mouse button and drag the selection box around the text
to be selected.

• Release the mouse button.

The data now selected will be displayed with a border around the text. This
text can now be modified using the Cut or Copy edit commands.
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Setup Command
The Setup menus are used to make various changes to the FORVUS
Emulator . This allows personal preferences to be made and saved to disk.
The following submenus are available under the Setup menu:

◊ Screen/Cursor
◊ Sound
◊ Printer
◊ Color
◊ Fonts
◊ Session Control
◊ HAP Control
◊ Reset Logical Unit

These sub-commands will be explained in more detail on the following pages.

+ Any options that are changed in Setup mode take immediate effect
on any active 3270 sessions.
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Screen/Cursor - Setup

The Screen/Cursor menu is used to customize the display of the current
session the operator is attached to. Clicking on the Screen/Cursor selection
on the Setup menu will display the following dialog box:

Status Indicators
The Row/Column and Activity Indicator may be enabled/disabled by check-
ing the appropriate box.

Cursor
The shape of the cursor may be modified by checking either the Underline
or Block selection. Selecting the Blink function will cause the session
cursor to blink.

Mark Unprotected
This function allow the operator to mark the unprotected fields that are

Figure 3-4. Screen Setup dialog box.
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displayed on the screen. The characters displayed in the unprotected fields
may be selected from either a Single dot, Double dot, Underline, or a
Box character. When data is placed in these fields, the mark unprotected
character will be replaced with the character entered. Selecting Off will
disable this function.

Rule
The rule style may be changed between a Crosshair, Horizontal, or
Vertical cursor. Selecting the Stationary box will freeze the rule cursor
on the display, which may be used when aligning text on the display surface.

Case
This selection is used to choose between Monocase or Dualcase character
display. Selecting monocase will display uppercase characters only; selecting
dualcase will display characters in upper and lower case (as they are entered
from the keyboard).

Hotspots
This group box is used to enable the selected hotspot on the display. There
are three (3) types of hotspots:

• Light Pen Fields - These hotspots are the 3270 type light pen fields, ?,
>, and &.

• Defined Names - These hotspots are the names as defined under the
hotspot customization program.

• Copy and Enter - The Copy and Enter hotspot will copy the word
pointed to by the mouse cursor to the 3270 cursor location and send an
Enter key to the host application.
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Sound - Setup

The Sound menu is used to customize the display of the current session the
operator is attached to. Clicking on the Sound selection on the Setup menu
will display the following dialog box:

Alarm Controls
The alarm controls give you a choice of modifying the alarm Volume, Tone,
and Duration of the FORVUS Emulator screen. Moving the scroll bar for
each control will modify the current settings for the alarm.

To test the alarm settings, press the Test Alarm pushbutton at the bottom
of the alarm control group box.
Click Controls
The click control will allow you to change the state of the keyboard clicker
and also the Volume of the click.

Figure 3-5. Sound Setup dialog box.
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State
To change the state of the keyboard click, select one of the choices below:

• Normal - Clicks with every keystroke press; does not click when an error
condition occurs.

• Reverse - Does not click until an error condition occurs.

Volume
Moving the scroll bar for the Click Volume will modify the current settings
for the keyboard clicker.

To test the click settings, press the Test Click button at the bottom of the
click group box.

Chapter 3     Operation       47



Printer - Setup

The Printer menu is used to customize the format of the print that is directed
to the attached printer. Clicking on the Print selection on the Setup menu
will display the following dialog box:

Paper Format
Characters per Inch
This selection sets the characters per inch for a LOCAL print operation.
Select either 10, 12, or 17 characters per inch.

Lines per inch
This selection sets the lines per inch for a LOCAL print operation. Select
either 3, 4, 6, or 8 lines per inch. 

Print Options
Default to 17 CPI
This feature is used to automatically switch to 17 Characters per Inch when
a Mod 5 screen print request is sent to the LOCAL printer. Select the check

Figure 3-6. Local Print Setup dialog box.
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box to enable this feature.

Print with Attributes
This feature allows the operator to enable or disable the print with attribute
feature. When this function is disabled, the LOCAL print will not print the
underline or bold attribute on the attached printer. Select the check box
to enable this feature.

Suppress Null Lines
This function is used to skip the printing of "null" lines on the display to the
LOCAL printer. Select the check box to enable this feature.

Select Printer
To select the current printer attached to the FORVUS Emulator, select a
printer from the "Select Printer" list box. These printers are provided by the
Windows resources and any printers to be added must be added by using the
Windows Print Manager.

To configure the selected printer, (landscape or portrait, paper width etc.)
press the Configure pushbutton at the side of the Select Printer Selection.
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Color - Setup

The Color menu is used by the operator to customize the display colors for
the Base Field Attributes, the Extended Field Attributes and various Display
areas shown on the session display. Either the foreground or background
color may be changed for the various fields (exception: Screen background
will only allow the background color to be changed).

Clicking on the Color selection on the Setup menu will display the following
dialog box:

+ Care must be taken when selecting foreground and background
colors; setting them to the same color will result in no data
displayed!

Figure 3-7. Color Setup dialog box.
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Base Field Attributes
To modify the Base Field Attribute settings, click on the drop-down icon.
You will then have the choice between selecting the attribute field to modify.
The choices include:

• Normal, Unprotected
• Normal, Protected
• Intensified, Unprotected
• Intensified, Protected

After choosing the selection to modify, click on the foreground and back-
ground selections on the right side of the menu box. As you modify the colors,
a sample display text field will display the current selections chosen.

Extended Field Attributes
To modify the Extended Field Attribute settings, click on the drop-down
icon. You will then have the choice between selecting the attribute field to
modify. The choices include:

• Blue
• Red
• Pink
• Green
• Turquoise
• Yellow
• White

After choosing the selection to modify, click on the foreground and back-
ground selections on the right side of the menu box. As you modify the colors,
a sample display text field will display the current selections chosen.

Display Options
To modify the Display Options settings, click on the drop-down icon. You
will then have the choice between selecting the display option to modify. The
choices include:
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• Operator Status Row
• Screen Background
• Rule
• Print Trim Border

After choosing the selection to modify, click on the foreground and back-
ground selections on the right side of the menu box. As you modify the colors,
a sample display text field will display the current selections chosen.

+ 

Return Colors to Default Settings
To change ALL colors to the factory default settings, press the Default
pushbutton at the bottom of the dialog box. You will then be prompted before
any colors will be changed.

Press OK to return all Colors to the factory default settings.

Exception: Screen background will only allow the background
color to be changed. The foreground selection is ignored.

Figure 3-8. Default Color dialog box.
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Session Control - Setup

The Session Control dialog box allows the operator to customize the Multiple
Logical Session feature of the host. Selecting the MLS session (A-H) will
inform the FORVUS Emulator to send the required key sequence to display
the selected session.

Clicking on the Session Control selection on the Setup menu will display
the following dialog box:

Session Title
To enter the name of the current session, (which will be displayed in the
title bar of the session window) place the cursor in the edit control and enter
the desired name.

Session
Click on the desired session (A-H) to use with the MLS feature.

Figure 3-9. Session Control dialog box.
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Font - Setup

The Font menu will allow you to select the font to be displayed on the current
session window. Both the font style and size may be changed to complement
the attached video display.

Clicking on the Font selection on the Setup menu will display the following
dialog box:

+

While a particular style and size may be selected,  you may elect to select
Auto Font Sizing and/or Auto Screen Sizing.

• Auto Font Sizing - When selected, the FORVUS Emulator will change
the font size to adapt a full screen display with the largest possible font
inside the current window.

• Auto Screen Sizing -  When selected,the FORVUS Emulator will modify
the current window to remove "blank" areas around the session text.

Although the Windows environment allows the use of multiple font
styles, the FORVUS Emulator will only allow the 472-3270 style
font to be displayed in the font selection dialog box. This ensures
that the 3270 style characters found on the operator status row will
be displayed correctly.

Figure 3-10. Font Selection dialog box.
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HAP Control - Setup

The HAP (Host Addressable Print) Control will allow the operator to send
paper and control commands to the host addressable printer.

Clicking on the HAP Control selection on the Setup menu will display the
following dialog box:

Paper Control
You can send a line feed or a form feed command to the host addressable
printer from the Paper Control group box. Press the Line Feed or the Form
Feed pushbuttons to perform the desired function.

Session Control
You can cancel a print job or send a PA1 or PA2 session control command
to the host addressable printer from the Session Control group box. Press
the Cancel Print, PA1 or PA2 pushbuttons to perform the desired function.

Figure 3-11. HAP Control dialog box.
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Reset Logical Unit - Setup

The Reset Logical Unit menu command will force the emulator to exit the
Online session and re-establish communication with the attached control
unit. This may be necessary when a new configuration file is loaded and the
operator wishes to use the new parameters the file contains.

Clicking on the Reset Logical Unit selection on the Setup menu will display
the following dialog box:

Pressing the OK pushbutton will reset the logical unit in the attached
control unit.

Pressing the Cancel pushbutton will return to the session display without
resetting the logical unit.

+

Record/Play Commands
The Record/Play menu allows the operator to save and recall keyboard
sequences entered from the keyboard.

Note: When this command is executed, the current application’s
data may be lost! This command simulates a Power Off - Power
On sequence to the control unit.

Figure 3-12. Reset Logical Unit dialog box.
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The following submenus are available under the Record/Play menu:

◊ Play
The play function will allow you to start a keyboard playback sequence from
a previously recorded record/play file. To begin a play sequence, follow the
steps below:

• Place the 3270 cursor at the point on the screen you wish to playback a
sequence.

• Select Play from the Record/Play menu.
• Click on the desired file that contains the playback sequence.

◊ Begin Recording
The Begin Recording function will start a new recording key sequence to be
saved to a file. This sequence is explained below:

• Place the 3270 cursor at the point you wish to begin recording.
• Select Begin Recording from the Record/Play menu.
• Enter the key sequence you wish to record.

◊ End Recording
The End Recording function will end the current recording sequence. This
sequence is explained below:

• Select End Recording from the Record/Play menu.
• Enter the filename you wish to save this recording sequence to.

◊ Pause
If you wish to enter a Pause sequence while recording, select Pause from the
Record/Play menu. When you are playing back a key sequence that has a
pause inserted, you will see the pause reminder on the operator status row.

◊  Resume
When you are playing a recorded key sequence, you may encounter a pause
indicator on the operator status row. This means that when the key sequence
was recorded, a pause was inserted. This is helpful when it is anticipated
that certain system sequences may take a varying amount of time to
complete an operation. Inserting a pause sequence and thereafter issuing a
Resume sequence will continue the operation. 
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In response to the pause sequence, you may:
• Select Cancel from the Record/Play menu - to end the Play operation.
• Select Resume from the Record/Play menu - to complete the Play

operation.

◊ Cancel
The Cancel function is used to:

• Play - Cancel a playback sequence in progress.
• Record - Cancel a record sequence in progress.

Canceling a Play sequence in progress

If you wish to stop a play sequence while it is in progress, follow the steps
below:

• Press any key on the keyboard -or- press the left mouse button.
• Respond Yes to the dialog box.

Accessories Commands
The Accessories menu will allow you to execute Windows application pro-
grams. You may elect to start the following programs without exiting the
emulator.

◊ Calculator
◊ Notepad
◊ Calendar
◊ Clock
◊ Cardfile

To start a program from the Accessories menu, click on the desired program
name.

+ -When starting an application under the Accessories menu, the
application will remain active even if the emulator is exited or
terminated.
-Accessories availability is dependent on version of Windows.
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Help Commands
The FORVUS Emulator provides an on-line help program that will provide
operator assistance.

The following facilities are provided with the Help system:
• Help with Help - Provides the operator an overview with the Microsoft

Windows Help system.
• Help Index - Provides the operator an INDEX to procedures and

commands for the the FORVUS Emulator.
• Keyboard Help - Provides the operator on a key-by-key basis, the system

unit keyboard key to 3270 function Help display.

+
Selecting one of the above Help topics will invoke the Microsoft Help facility.
Exiting the Help facility will return the operator to the FORVUS Emulator.

TIP: Double clicking the mouse on the selected key will perform
that 3270 function on your active session.

Figure 3-13. Sample Help topic.
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Rule Cursor
The FORVUS Emulator contains a Rule Cursor that may be enabled or
disabled while working in the active 3270 session. This feature enables you
to quickly locate data that may be aligned in columns or tables.

If the Rule Cursor is tagged as Stationary in Screen/Cursor setup, it can
be placed on the active window in a fixed position. If the Rule Cursor is
tagged as Movable, it track the current cursor location on the display.

If you are using a color display, the color of the Rule Cursor may be changed
to any one of 16 colors. Refer to Color - Setup on page 50 for color setup
information.

Local Screen Printing
The FORVUS Emulator will allow the operator to print all or part of the
screen to the attached system printer.

Printing the entire screen

To print the entire screen to the attached printer, select Local Print from
the File drop-down menu. The text shown on the session window will be
printed on the attached local printer.

Printing part of the screen

To print only a selected portion of the screen, place the mouse cursor at the
beginning of the area you wish to print;press the left mouse button and drag
the print trim border around the area of text you wish to print. Select Local
Print from the File drop-down menu. The area inside the print trim box will
be printed on the attached local printer.
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Hotspots
Hotspots are areas on the display that the emulator translates to keyboard
functions when double clicked with the mouse cursor. There are three (3)
types of hotspots recognized by the emulator. These are:

• Light Pen Fields - 3270 Style Light Pen fields that are recognized by the
application program. Double-clicking on the "designator" characters ?,
>, or & will send light pen sequences to the host.

• Defined Names - are user-definable hotspots that send a specific
keyboard functions when the emulator detects that a defined name
hotspot has been double-clicked.

• Copy and Enter - will copy the word clicked on (separated by null or
spaces on the front and back of the word) to the area located by the
application cursor and send an Enter key function to the application.

To enable or disable the above hotspots, refer to Screen/Cursor setup found
on page 44 for more information.
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Pop-Up Keypad
The FORVUS Emulator contains a user-definable pop-up keypad that
contains function keys that are frequently used. The keypad actually con-
sists of two (2) keypads in one layout. Found at the bottom of the keypad is
the Next Keypad pushbutton. Pressing this pushbutton when the keypad is
displayed will result in the display of the alternate keypad. The keypad is
displayed on the screen when the right mouse button is clicked. When one
of the pushbuttons on the keypad is pressed, the appropriate function is sent
to the control unit.

A sample keypad is shown below:

The layout of the keypad layout is contained in a pop-up configuration file.
Refer to page 18 for more information on how to modify the Pop-Up Keypad
configuration file.

Figure 3-14. Sample Pop-Up Keypad.
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Status Row Messages
This chapter describes the messages that appear on the status row of the
FORVUS Emulator display window. Also, the action to be taken when a
particular indicator appears is described in this section. The operator status
row is the displayed row below the separator line and the data area above.
System messages are grouped into distinct areas of the status row, these
being System Status, Do-Not-Enter, Communication Reminders, Shift and
Mode Status, Printer Status, and Row/Column. These functions will be
described in the sections that follow.

• System Status   - Displays current attachment and ready status of the
FORVUS Emulator program. (Columns 1-8)

• Do-Not-Enter   - Displays keyboard locked condition and explanation
for this condition. (Columns 9-20)

• Reminders   -  Display Communication Reminders, both permanent
and temporary communication link errors. (Columns 21-28)

• Shift Status   - Displays current Shift status of the FORVUS Emulator.
(Columns 38-40)

• Mode Status   - Displays current Mode status such as Insert, Ex. Sel.
etc (Columns 41-44).

• Printer Status  - Displays current Printer status that is attached to
the FORVUS Emulator. (Columns 60-65)

• Record/Play  -Displays current Record/Play indicators.
• Row/Column  - Displays current Cursor position relative to the position

of the Display Buffer.  (Columns 73-80)
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System Status
 
J 3274 Ready 
The FORVUS Emulator is connected to a 3274 type control unit.

H 3276 Ready
The FORVUS Emulator is connected to a 3276 type control unit.

S 3174 Ready
The FORVUS Emulator is connected to a 3174 type control unit.

I 43XX Processor Ready
The FORVUS Emulator is connected to a 43XX Processor.

R Online A
The communication access method between the controller and host system
is using a method other than SNA.

S Online B
The communication access method between the controller and host system
is using  SNA.

I My Job
The FORVUS Emulator is currently connected to an application type
program.

B System Operator
The FORVUS Emulator is connected to the host and is communicating with
the system operator.

TEST  Test
The control unit is in Test mode.

K Unowned
The FORVUS Emulator is connected to the host but is not connected to an
application program or to the system operator.
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Do-Not-Enter
The Do-Not-Enter symbol indicates to the operator that input to the
FORVUS Emulator display is inhibited. The condition indicated must be
cleared before further input will be accepted. More information is displayed
to the right of the locked condition defining the cause of the Do-Not-Enter
condition.

The following examples explain how to clear the Do-Not-Enter function and
restore the keyboard to an unlocked condition.

E TWUV 5nn Communications Check
There is a problem with the communications link between  FORVUS Emu-
lator and the host. When you activated an AID key, there was a Communi-
cations Reminder informing you that there was a problem with the link
between the host and your Display. Press RESET to restore the keyboard
to an unlocked condition.

E Z nnn Machine Check
There is a machine detected check with the control unit or with the FORVUS
Emulator. Pressing the RESET key may or may not restore the keyboard to
an unlocked state.
 
E PROG nnn Program Check
An error in the data stream from the host has caused the control unit to
inhibit operation of the FORVUS Emulator keyboard. This may be caused
by a program ‘bug’ in an application program (eg. a  Mod 5 program writing
to a Mod 2 display.) Contact the system operator if this situation arises.

E AE Operator Unauthorized
This symbol is displayed when the operator attempts to print to a device
which has not been assigned to the control unit. Re-check the printer
assignment and retry the operation. Pressing the RESET key will restore
the keyboard to an unlocked condition.

E PQ Time
The previous command is taking more time to respond to your request than
is normally needed. Should this symbol be displayed more than a few
minutes, contact your system operator.
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E -f Minus Function
The function that you requested was an unavailable keyboard function.
Pressing the RESET key will restore the keyboard.

E A> More Than
While inserting characters using the INSERT function, the field had no more
space for the data you were entering. Pressing the RESET key will unlock
the keyboard and remove this symbol. Note: pressing RESET will remove
the emulator from insert mode, press the INSERT key to re-enter that mode.
 
E MAN Go Elsewhere
This symbol is displayed when you tried to change the screen input but the
cursor was not inside an input field. This symbol is also displayed when the
Cursr Sel key is pressed and the cursor was not in a light-pen type field.

E SYSTEM System Lock
This symbol is displayed when the application program has locked the
keyboard. Pressing the RESET key will restore the keyboard for data input.

E ANUM Numeric Input Only
You tried to enter non-numeric data in a field that is specified as numeric
data only. Only the characters 0-9, the DUP key, period and comma are the
only valid entries for this field. Pressing the RESET key will unlock the
keyboard and remove this symbol.

E A#? What Number
The control unit did not accept the last input. It is caused by:

•  While in TEST mode to the control unit, you entered a test number
that was invalid.

•  You entered an incorrect printer ID number.

E ?+ What?
The emulator keyboard is locked because the input was incorrect or was not
recognized. No input data will be accepted. Press RESET to restore keyboard
to an unlocked state.

E XMB Message Received
The emulator received and rejected a message from the system operator or
control program. Press RESET to restore the keyboard to an unlocked state.
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E -S Minus Symbol
While inputting data, you pressed an unsupported key. Press RESET to
restore the keyboard to an unlocked state.

E XTZ Printer Not Working
There is a problem with the printer that is assigned to the emulator. Attempt
to locate the problem with the printer, (Paper Out, Not Selected) before
continuing. Press the QUIT key to unlock the keyboard. 

E XTXPQ Printer Busy
The emulator encountered a busy printer while attempting to start a print
request. You may elect to wait for the current print operation to complete
or press the QUIT key to unlock the keyboard.

E XTXPQPQ Printer Very Busy
The emulator is unable to print because the host has started a print to the
selected printer. Time is needed to complete the print to the device. Press
QUIT to unlock the keyboard.

Communication Reminders

Communication reminders are provided to the status row to inform the
operator of the current state of the communication link between the
FORVUS Emulator display and the host system. Messages may vary, de-
pending on the type of control unit attachment to your host system. Not all
messages are error messages, some are provided as information only. Refer
to Appendix A, "Error Messages" for a more detailed explanation.

E TWUV 5nn Communication Check

The control unit has detected a problem in the communications link with
the host system. Two major types of errors are reported:

•  A permanent error has occurred with the communication link, causing
all terminals on the control unit to report the error.

•  A temporary line error occurred causing the control unit to retry the
failing operation again to the host. If the retry is successful, the
communication reminder will be reset and the condition cleared.
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Shift and Mode Status
F Upshift
This symbol is displayed when the keyboard is in Upshift mode. All alpha-
numeric characters will be displayed in uppercase.

NUM Numeric
This symbol is displayed when the cursor is located in a numeric field, and
the Numeric Lock function is enabled. Only characters 0-9, minus sign,
period or a comma may be entered in this field.

D Insert
This symbol is displayed when the keyboard is in Insert mode. Characters
entered will be inserted to the right of the cursor. Pressing RESET will exit
insert mode.

C Extended Select
This symbol is displayed when the keyboard is in Extended Select mode.
Entering this mode will redefine the Program Function keys. Pressing any
key other than a PF key will exit this mode.

Printer Status

XTY nn Printer Printing
The printer that is identified by "nn" is currently busy printing.

XTO nn Printer Failure
The printer that is identified by "nn" has stopped printing due to a failing
condition. Check the printer and correct the condition before attempting to
start a new print. 

XTX nn Printer Assignment
The FORVUS Emulator is currently assigned to the printer with the ID "nn".
These ID’s are as follows: 

•   1-31: Control Unit printer port numbers
•   70-85: Printer Class number
•   99: Local Printer attached to FORVUS Emulator 
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XTX ?? What Printer?
The previous printer assignment has been changed. Press the printer
IDENT key to display the new printer ID assignment.

XTX -- Assign Printer
This symbol is displayed to inform the operator that a new printer ID may
be assigned. Entering a new ID will replace the "- -" on the status row.

Error Status

2%% Invalid Keyboard Attached
This message is displayed when the keyboard ID and the control unit ID do
not match. This may occur when the keyboard is configured for a 3472
keyboard and the control unit is customized to expect a 3278 keyboard.
Re-check the keyboard selected in the SETUP panels or contact your system
operator.

A > Record Buffer Full
This indicator is displayed when the contents of the RECORD buffer is full.
You must remove keystrokes from the buffer before additional keystrokes
may be added.

Entry Assist Indicators

DOC Document
This indicator is displayed when the keyboard is in DOCUMENT mode.
Refer to your control unit user’s guide for more information on "Entry
Assist".

L Word Wrap
This indicator is displayed when the WORD WRAP function is enabled. Refer
to your control unit user’s guide for more information on "Entry Assist".
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Record/Play Status

R Record Mode
This indicator informs the operator that the emulator is currently in
RECORD mode.  The number displayed to the right of the indicator shows
the number of keystrokes that remain in the RECORD memory area.
Pressing the QUIT key while in this mode will CANCEL this recording
session and return to normal mode.

P Play Mode
This indicator informs the operator that the emulator is currently in PLAY
mode. Pressing the QUIT key will stop the PLAY operation and return to
normal mode. 

R AD Recording Paused
This indicator informs the operator that the PAUSE key has temporarily
stopped the RECORD operation. One of three steps may be taken at this
point:

•  Pressing the QUIT key will cancel the RECORD operation.
•  Pressing the PAUSE key will resume the recording process for this key.
•  Pressing the RECORD key will end the recording process and save the

keystrokes.

P AD Playback Paused
This indicator informs the operator that the playback of the current opera-
tion has been temporarily stopped. You may:

•  Press the QUIT key to end the PLAY operation.
•  Press the PLAY key to resume the playback operation.
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Problem Determination
This section of the manual is provided to assist you with problems you may
have while using the FORVUS Emulator. Messages that might appear on
the Operator Status Row may indicate an error condition while some may
be for information only. If you see indicators on the Status Row, refer to
Chapter 4, "Status Row Messages" on page 63.

If the emulator should indicate a problem, refer to Appendix A, " Error
Messages" for a more detailed description.

If you are having problems other than communicating with your host, follow
the steps below to further assist you with solving the problem.

Initial Checks
1. If your system unit does not power up as it normally does, check that
power is available to both your monitor and system unit. If power is available
to both units proceed to step 2.

2. Check all connections to the system unit (keyboard,monitor, and any other
connections).

3. Check the contrast and brightness controls on the monitor. Should the
screen appear, re-adjust to a comfortable level.

4. If your system is equipped with diagnostics (power on diagnostics, memory
test, alarm "beeps") make sure these tests pass normally. If these diagnostics
"fail", refer to your system unit user’s manual to further identify the system
problem.

+ Expanded memory Users: Make sure your expanded
memory manager does not interfere with the memory address
space of your communications adapter (coax adapter, token
ring adapter, etc.) by excluding the required memory area per
the hardware manufactures specifications. 
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FORVUS Emulator Does Not Load

1. Perform Initial Checks (See Page 71) and verify Configuration selections.

2. Is the communications adapter card installed correctly in the system unit?
Make sure the Adapter card is firmly seated in the system unit’s Main board.

3. If required, has a network driver (for example, IPX/SPX,LLC) been loaded
into memory before the Emulator communications driver is started.

+

4. The FORVUS Emulator displays an error message while trying to load -
Refer to Appendix A, "Error Messages" for further information.

FORVUS Emulator loads. . . 
but does not communicate with the Host

1. Perform Initial Checks (see Page 71) and verify Configuration selections.

2. Make sure the communication cable is properly attached to the Commu-
nication Adapter. (loose wires, frayed cable, etc.)

3. Are other devices communicating with the same gateway controller? If
not, the gateway controller may be malfunctioning. Check with your system
operator.

4. If possible, have your system operator restart the line that you are
communicating. If the host is operational and other devices are functioning
normally, power your system off and back on to retry the operation. 

5. LANSYS Connection only - Run the CHKLNK program described in
Appendix D.

IPX/SPX is required for SAA connection.

LLC is required for 802.2 and LANSYS connection.

TCP/IP stack is required for TN3270 connection.
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6. SAA connection only - 505-xx errors (no host connection) - When the
FORVUS Emulator is loaded, a 505-xx error will occur if there is no
communication with the host. The 2-digit number following the 505 may
help you identify the cause. See Appendix A "Status Row Messages" for more
information.

   +

Viewing Connection Information (SAA only)
To view the SAA Connection Information screen, follow these steps:

1. Press the Test key from any online screen to enter Test mode. Refer to
the Pop-Up keypad (Page 62) or Keyboard Help on the FORVUS Emulator
session Help menu to locate the Test key function.

2. Press the 3 key from the Main Test menu. The SAA Connection Informa-
tion screen is displayed.

3. To leave the SAA Connection Information screen, press the Test key.

A blank screen with no status line usually occurs if IPX/SPX
has not been loaded.
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Product support
If you have a question that isn’t answered in this manual, our Product
Support Department can help. Free telephone support is provided for 90
days to you as a new user when you return the enclosed registration card.
Many questions can be answered in this manual. However, if you’ve checked
your manual and still need assistance, please have your computer powered
on and the following information available:

• your name and address
• your FORVUS Emulator software serial number
• your computer make and model, the amount of RAM installed, the type

and capacity of your hard disk and floppy drives, the display adapter and
monitor type, printer name and model number

• Version number of Novell NetWare for SAA (if applicable)
• Type of coaxial adapter installed (if applicable)
• Type of network adapter installed (if applicable)
• TCP/IP vendor stack (if applicable)
• Windows version number
• DOS version number
• contents of your CONFIG.SYS and AUTOEXEC.BAT files
• a clear description of your problem

Call Product Support at (919) 954-8380 between 9 a.m. and 5 p.m. EST
(excluding US holidays). We will be happy to assist you.

We may also be contacted via the Internet at: http://www.forvus.com

Defective items
If you have registered your software and find a defect in your diskettes or
manual within 90 days of the date of purchase, you may return the defective
item for a replacement. Proof of purchase is required.
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File Transfer
The FORVUS Emulator is capable of sending and receiving files from a host
mainframe that uses the VM/CMS, TSO, or CICS environment. This enables
the operator to transfer files to and from other users via the host application.

Two types of file transfer tasks supported by the emulator are IBM’s
IND$FILE and PCXFER. IND$FILE is initiated from the PC while PCXFER
is initiated from the host.

Requirements for File Transfer
Before you attempt to transfer files between the system unit and the host,
make sure the following steps have been taken:

• The host file transfer programs have been installed. Check with your
system operator should you need assistance with the host application.

• Make sure the host will not send any unsolicited messages while the file
transfer is in progress. Enter the host command to "set messages off"
before starting the file transfer.

Log on to the host application you will be transferring the FORVUS
Emulator files to/from.

+ 

Mainframe System Requirements
Subject to the host system you use, one of the following supported file
transfer programs must be installed at your host site:

• OS/VS2 TSO-IBM 3270-PC File Transfer Program Rel 1 (5665-311)
• VM/CMS-IBM 3270-PC File Transfer Program Rel 1 (5664-281)
• PCXFER

When the file transfer is in progress, both the emulator session and
the host session will be dedicated to the task. Neither session may
be used until the file transfer is complete.

Any attempt to enter data from the keyboard may disrupt the file
transfer between the host and the emulator session. Data may only
be entered in response to messages received from the file transfer
program.
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The installation and support of the IBM host supported file transfer program
is outside the scope of this document. See your system administrator for
additional help.

Beginning a File Transfer
To initiate a file transfer, select File Transfer found under the File drop-down
menu. The following dialog box will appear:

Fill in the following information when sending a file to the host or receiving
a file from the host:

Host File - Enter the name of the host file to be used with the file transfer.
The format is filename<sp>file type.

PC File - Enter the name of the PC file to be used with the file transfer. The
format is d:\path\filename.ext where d: is the drive and \path is the subdi-
rectory of the file. Note: You must include the drive and directory of the
desired PC file.

Figure 6-1. File Transfer dialog box.
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Host - This setting determines the host environment; select between TSO,
 CMS or CICS.

Type - Select the type of file transfer, IND$FILE or PCXFER. IND$FILE
file transfers are initiated at the PC. PCXFER file transfers are initiated at
the host.

Options - The following options are available:
• ASCII/EBCDIC Translation - This option will translate ASCII files sent

to the host to EBCDIC and EBCDIC files received from the host to
ASCII.
If this option is not selected, files are transferred between the PC and
host without being translated.

• CRLF Addition/Removal - This option replaces trailing spaces on files
transferred from the host with carriage returns (CR)  and line feeds
(LF).
If this option is not selected, files are received from the host with trailing
spaces instead of carriage returns and line feeds at the end of lines. Files
are sent to the host with carriage returns and line feeds instead of
trailing spaces.

• Append - Select this option to have the transferred file appended to an
existing file on the receiving system.
If this option is not selected and a file with the same name as the
transferred file already exists on the receiving system, the transferred
file overwrites the file on the receiving system.

• More Options - Pressing this key will display another dialog box of
options; the options available depend on the selected host environment.

- For IND$FILE file transfers, refer to "IND$FILE" File Transfers on
the following page.
- For PCXFER file transfers, refer to "PCXFER File Transfer Options"
on Page 83.
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IND$FILE File Transfer Options

Record Format - This option informs the host of the record format to use
for the new data set to be created. Select between:

• Host Default
• Fixed
• Variable
• Undefined

Record Length - This option informs the host of the logical record length to
use when creating a new data set. Choose between:

• Host Default 
• Operator specified length

Language - This selection determines the language that will be used during
the file transfer operation.

Code Page - Select the country code page for translation from ASCII to
EBCDIC and EBCDIC to ASCII.

Figure 6-2. File Transfer Options dialog box.
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Additional Options - Use this box to enter one or more of the following flags
(each flag must be preceded by a space):

• /H=nnn Host timeout value (nnn=timeout value in seconds). Sets the
length of time the Send/Receive programs waits for a host response
before timing out.

• /Q Quiet mode. Suppress message display during file transfer.
• /S Display statistics. Displays statistics for a transfer, including the

number of bytes transferred and the host timeout value. It is
recommended that you use the /S flag to determine these values before
using the /H flag to change them.

• /W Display warning messages. Warning messages are not sent unless
this flag is specified.

• /? Help. Displays a menu of these flags.

Space allocation options available with TSO Environment

If you have specified a file transfer with a TSO host, the following space
allocation options are available:

Allocation Units - This option informs the host of the type of space to allocate
for the new data set. The choices are:

• Host Default
• Cylinders
• Tracks
• Average Blocks

Space - This option informs the host the amount of Primary and Secondary
space to allocate during the file transfer.

Block Size - This option informs the host of the data block size to use when
creating a new data set. The choices are:

• Host Default
• Operator specified length
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IND$FILE File Transfer Messages

The following messages are provided to inform the operator of the current
status of the file transfer application. Some of these messages are for
information only, while other messages may report an error situation.

TRANS01 File transfer command being processed.
This message is displayed when the file transfer command has been accepted
and communication between the host system and the system unit has begun.

TRANS02 Number of bytes of file transferred so far: ==> XXXXX
This message informs the operator of the number of bytes that have been
transferred between the host system and the system unit. 

TRANS03 File transfer complete.
This message is displayed when the file transfer has completed without
errors.

TRANS05 Personal Computer filespec incorrect: file transfer can-
celed.
This message informs the operator that the DOS filespec was either not
found or incorrect. Verify the drive, path, filename and extension entered
matches the file you wish to use.

TRANS06 Command incomplete: file transfer canceled.
The options entered for the SEND or RECEIVE command were invalid or
not found. Verify the parameters entered and retry the operation.

TRANS10 Host has not responded within timeout period.
This message is displayed when the host fails to respond within 5 minutes.
Contact your system operator or retry the operation.

TRANS12 Error writing to damaged or full PC Disk: File transfer  
          canceled.
This message is displayed when DOS reports a problem while writing to the
destination disk. The disk may be full or the media may be damaged.

TRANS25 Keyboard inhibited: file transfer canceled.
While the file transfer was in progress, the host session locked the keyboard.
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TRANS27 Out of sequence host: file transfer canceled.
This message is displayed when the host communication sequence did not
correspond with the expected sequence. This may be due to either a program
or system error.

TRANS41 Host file replaced by new file.
This message is issued to inform the operator that the SEND command has
replaced an existing file with a new file.

TRANS42 Disk file replaced by new file.
This message is issued to inform the operator that the RECEIVE command
has replaced an existing DOS file with a new file.

TRANS43 Break in progress... please wait.
You pressed the Ctrl+Break key sequence to terminate the file transfer
operation. The transfer program is now in progress of informing the host to
terminate the file transfer.

TRANS44 Transfer statistics: Total number of chars transferred =  
         XXXXX
This message is displayed to inform the operator of the total number of
characters that were transferred between the host and the system unit.

TRANS45 ...actual number of data bytes=XXXXXXXX , overhead =
         XX %
This message informs the operator of the number of DATA bytes actually
contained in the file while the overhead percentage taken to transfer the file
is contained in XX.

TRANS48 File transfer terminated.
This message is displayed when the file transfer is terminated either by a
program or system error or initiated with the Cntl+Break sequence from
the system unit keyboard.

TRANS49 Hardware malfunction, command timeout.
This message is displayed when the file transfer program has detected an
error with the FORVUS Emulator Hardware Adapter. Retry the operation
or contact your system operator.
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TRANS50 Host is not processing keys.
This message informs the operator that the host control unit is not accepting
keystrokes from the system unit. The control unit may have logged an
excessive amount of communication errors or the system may be down.
Contact your system operator.

TRANS54 Cursor in protected field.
While the file transfer was in progress, the cursor was found in a protected
field. Retry the operation or contact your system operator.

TRANS55 Host input area too small.
While the file transfer was in progress, the cursor was found in an unpro-
tected field that was not large enough to accept the data to be sent. Retry
the operation or contact your system operator.
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PCXFER File Transfer Options
The following options are available for the PCXFER file transfer as shown
below:

Record Format - This option informs the host of the record format to use
for the new data set to be created. Select between:

• Host Default
• Fixed
• Variable

Record Length - This option informs the host of the logical record length to
use when creating a new data set. Choose between:

• Host Default 
• Operator specified length

Language - This selection determines the language that will be used during
the PCXFER file transfer operation.

Figure 6-3. PCXFER File Transfer Options.
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Additional Options - Enter any options defined by the host.

Record Number Range - Select the Host Default length of the record to be
transferred from the CMS file or specify the starting record number (First
Record) and the number of records in the file (Count).

Options - The following options are available for PCXFER file transfers:
• Expand Tabs - Select this option to expand the tabs when transferring

data from the PC to a CMS file. Specify a number of columns to expand
for each tab. The default expansion size is 8.

Expanding the tabs may cause a record to overflow to the next record.

If you specify a tab expansion value larger than the file’s record length,
a new record may be produced for each tab character.

If you do not select this option, tab expansion is suppressed.

• Add Line Numbers - Select this option to insert line numbers in the data
during transfer from the PC to the CMS file. The line numbers are
inserted in the last eight positions of each record in increments of 10.
The inserted line numbers do not overlay data in the file.

• Wait After Completion - Deselect this option to automatically return
control of the terminal to CMS after a file transfer is completed without
error. Control is not automatically returned if an error is encountered.

If you select this option, you must press a key to return control to CMS
after a file transfer.

This option is independent of the Wait After Error option.
• Wait after Error - Deselect this option to automatically return control

of the terminal to CMS after a file transfer is terminated because of
error. A message describing the cause of the termination is not left on
the display.

If you select this option, you must press a key to return control to CMS
after a file transfer termination. A message describing the cause of the
termination is left on the display until you press a key

This option is independent of the Wait After Completion option.
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Completing the File Transfer
After all options have been entered, select the type of file transfer you desire:

• Press Send File to send a file from the PC to the host.
• Press Receive File to receive a file from the host to the PC.

Press Cancel to exit the file transfer process without sending or receiving a
file.

File Translation 
When files are transferred between the host system and the system unit, if
the ASCII option is specified, a translation between ASCII and EBCDIC will
take place. This occurs because the PC utilizes the ASCII alphanumeric
character set and the host system utilizes the EBCDIC alphanumeric
character set. 

The following observation should be noted while using the ASCII option:

• There are 3 character differences between the ASCII and EBCDIC
character sets. These are:

ASCII Symbol    ^    [     ]
EBCDIC Symbol   ¬     ¢      

Although these characters are displayed differently from host system to PC
system, their character codes remain the same.

Refer to the following pages for the translation tables.
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ASCII to EBCDIC Translate Table

0 1 2 3 4 5 6 7 8 9 A B C D E F

0 00 01 02 03 37 2D 2E 2F 16 05 25 0B 0C 0D 0E 0F

1 10 11 12 13 3C 3D 32 26 18 19 3F 27 1C 1D 1E 1F

2 40 5A 7F 7B 5B 6C 50 7D 4D 5D 5C 4E 6B 60 4B 61

3 F0 F1 F2 F3 F4 F5 F6 F7 F8 F9 7A 5E 4C 7E 6E 6F

4 7C C1 C2 C3 C4 C5 C6 C7 C8 C9 D1 D2 D3 D4 D5 D6

5 D7 D8 D9 E2 E3 E4 E5 E6 E7 E8 E9 4A E0 4F 5F 6D

6 79 81 82 83 84 85 86 87 88 89 91 92 93 94 95 96

7 97 98 99 A2 A3 A4 A5 A6 A7 A8 A9 C0 6A D0 A1 07

8 20 21 22 23 24 15 06 17 28 29 2A 2B 2C 09 0A 1B

9 30 31 1A 33 34 35 36 08 38 39 3A 3B 04 14 3E E1

A 41 42 43 44 45 46 47 48 49 51 52 53 54 55 56 57

B 58 59 62 63 64 65 66 67 68 69 70 71 72 73 74 75

C 76 77 78 80 8A 8B 8C 8D 8E 8F 90 9A 9B 9C 9D 9E

D 9F A0 AA AB AC AD AE AF B0 B1 B2 B3 B4 B5 B6 B7

E B8 B9 BA BB BC BD BE BF CA CB CC CD CE CF DA DB

F DC DD DE DF EA EB EC ED EE EF FA FB FC FD FE FF

86     FORVUS Emulator User’s Guide



EBCDIC to ASCII Translate Table

0 1 2 3 4 5 6 7 8 9 A B C D E F

0 00 01 02 03 9C 09 86 7F 97 8D 8E 0B 0C 0D 0E 0F

1 10 11 12 13 9D 85 08 87 18 19 92 8F 1C 1D 1E 1F

2 80 81 82 83 84 0A 17 1B 88 89 8A 8B 8C 05 06 07

3 90 91 16 93 94 95 96 04 98 99 9A 9B 14 15 9E 1A

4 20 A0 A1 A2 A3 A4 A5 A6 A7 A8 5B 2E 3C 28 2B 5D

5 26 A9 AA AB AC AD AE AF B0 B1 21 24 2A 29 3B 5E

6 2D 2F B2 B3 B4 B5 B6 B7 B8 B9 7C 2C 25 5F 3E 3F

7 BA BB BC BD BE BF C0 C1 C2 60 3A 23 40 27 3D 22

8 C3 61 62 63 64 65 66 67 68 69 C4 C5 C6 C7 C8 C9

9 CA 6A 6B 6C 6D 6E 6F 70 71 72 CB CC CD CE CF D0

A D1 7E 73 74 75 76 77 78 79 7A D2 D3 D4 D5 D6 D7

B D8 D9 DA DB DC DD DE DF E0 E1 E2 E3 E4 E5 E6 E7

C 7B 41 42 43 44 45 46 47 48 49 E8 E9 EA EB EC ED

D 7D 4A 4B 4C 4D 4E 4F 50 51 52 EE EF F0 F1 F2 F3

E 5C 9F 53 54 55 56 57 58 59 5A F4 F5 F6 F7 F8 F9

F 30 31 32 33 34 35 36 37 38 39 FA FB FC FD FE FF
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Error Messages
Install Error Messages
The following error messages are provided to assist the user with installing
the FORVUS Emulator on the system unit. 

No Drive Letter Specified in Destination Path

This message is displayed when FORVUS Emulator could not find a Drive
letter in the destination path that was specified. Make sure the drive is
specified in the destination path.

No Drive Letter Specified in Source Path

This message is displayed when FORVUS Emulator could not find a Drive
letter in the source path that was specified. Make sure the drive is specified
in the source path.

Source and Destination paths cannot be the same

This message is displayed when FORVUS Emulator detected that both the
source and destination installation paths are the same. Change the paths
before continuing.

Make Directory Error

This message is displayed when FORVUS Emulator could not successfully
create the directory specified. Check to make sure the drive specified
contains enough space for a new directory.

Error Copying Files

While copying the FORVUS Emulator program files, an error was reported.
There may not be enough room on the destination disk or a verify error may
have occurred while writing the files.

Error Modifying AUTOEXEC.BAT file

This message is displayed when FORVUS Emulator could not successfully
modify the file AUTOEXEC.BAT. Check to make sure the drive specified
contains enough space for a new file.

Appendix A     Error Messages       89



Error reading FILELIST file

This message is displayed when FORVUS Emulator could not successfully
read the file FILELIST. This file is used to verify the contents of the files to
be installed on the system unit.

No Keyboard Files Found

This message is displayed when FORVUS Emulator could not locate the .KBF

files. Verify  the disk contains the keyboard translate files on the disk and
path specified.

No Language Files Found

This message is displayed when FORVUS Emulator could not locate the
.MSG files. Verify that the disk contains the language message files on the
source disk and path specified.

Insufficient Disk Space to install FORVUS Emulator

This message is displayed when the install program detected that the
destination drive does not contain enough space to place the FORVUS
Emulator program files. Verify that the destination drive contains enough
free space to install the program files.

Insufficient Disk Space in "Windows" directory

This message is displayed when the install program detected that the drive
that contains the Windows directory does not contain enough space to place
required FORVUS Emulator program files. Verify that the Windows drive
contains enough free space to install the program files.

Invalid Characters in Directory Path

This message is displayed when the FORVUS Emulator installation program
detected invalid characters in a directory path. Re-check the path and
continue.

Error reading PROGMAN.INI

While attempting to read the Windows Program Manager setup file, an error
was detected. Retry the previous operation again.
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Not Enough DOS memory to run install

This message is displayed when the install program detected insufficient
DOS memory to execute. This may be due to too many active programs
running under Windows. Terminate any unneeded programs and retry the
operation.

Startup Error Messages
The device driver is not loaded.

This message is displayed when FORVUS Emulator has detected that the
device driver is not executing. Check the AUTOEXEC.BAT file and make
sure the "DEVICE=COMMDVR.EXE" statement is included.

The device driver is downlevel. Make sure you have re-booted since
installing the Emulator.

This message is displayed when FORVUS Emulator has detected that the
device driver that is currently executing is downlevel. Re-boot the system to
load and execute the new driver.

The Host Addressable Print setup for the new session is different from
the setup that is currently loaded and running. Do you want to replace
the existing HAP setup?

You have attempted to load a session that has different HAP parameters
from the setup that is currently running.

The setup parameters for the new session conflict with parameters that
are currently loaded and running. If you select ’YES’ all active sessions
will be reset. Do you want to load the new setup?

You have attempted to load session parameters that are different from the
parameters that are currently running. The new parameters require you to
reset all sessions currently active in order to use the new setup.
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Information Messages
Changes have been made which require the Communications Driver
to be reloaded. These changes may not take effect until you exit
Windows and reboot.

You have made changes which require the Communications Driver to be
reloaded. Since the Communications Driver is loaded from the AUTO-
EXEC.BAT file, your system must be re-booted for the new changes to take
effect.

Communication Reminders
Communication reminders are messages that are displayed on the operator
status row to inform the operator of the status of the communication link.
Listed below are explanations for common messages found on the emulator’s
operator status row.

This list is not all inclusive. For other communication reminders not listed,
refer to the IBM 3270 Information Display System: Reference Summary.

TWUV 501 Data Set Ready has dropped from the modem.

TWUV 504 There is no line connection with the host.

TWUV 505 Initial state at startup, awaiting response from the host.

TWUV 505-05 (SAA) No Communication Servers Found
No SAA servers responded to a Nearest Server Query broadcast or could not
connect to the nearest server. 

TWUV 505-08 (SAA) Could not find the specified SAA server.
The specified SAA server could not be found. Make sure that you have
specified a valid "COMM SERVER" name.

TWUV 505-12 (SAA) Error connecting to the specified SAA server. An
error occurred while trying to connect to the specified SAA server.

TWUV 505-15 (SAA) Error attaching to the specified SAA server. An
error occurred while performing an attach. The common cause for this error
is an incorrect "USER ID" or "PASSWORD".
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TWUV 505-18 (SAA) Could not find the service mapping agent. The
service mapping agent on the comm server could not be found.

 TWUV 505-22 (SAA) Could not find the specified service (LU) The
specified "LU" name or "LU POOL" could not be found or was not available
from from the specified "SERVICE PROFILE". Make sure you have specified
a valid "LU" or "LU POOL" name and they are available under the specified
"SERVICE PROFILE". If the "LU" name is correct, the specified LU is in
use.

TWUV 505-25 (SAA) Error opening route to the specified service (LU).
Refer to comm reminder 505-22.

TWUV 505-28 (SAA) Error opening route to the specified service (LU).
Refer to comm reminder 505-22

TWUV 505-30 (SAA) Connected to SAA Server- No Host Communica-
tions. The emulator is connected to the specified SAA server and service.
The specified SAA server is not connected to the Host or the specified LU is
not active.

TWUV 505-32 (SAA) Connection to the SAA Server has been inter-
rupted. The connection to the SAA Server was active but has since been
interrupted.

TWUV 510 The PU is not active.

TWUV 519 A message was received that was larger than the RU size.

TWUV 532 Approximately 20 seconds have elapsed without communi-
cation from the host.           

TWUV 588 (802.2) Could not initalize Token Ring adapter.

TWUV 589-01 (802.2) Token Ring does not contain enough SAP’s.

TWUV 589-02 (802.2) Token Ring does not contain enough stations.
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  TWUV 589-03 (802.2) Emulator could not open a Token Ring SAP.

TWUV 590 (802.2) Emulator could not open the Token Ring adapter. 
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Communications Driver
If you elected not to have the installation program install the communica-
tions driver and are not running the Emulator’s communication driver as a
DLL that will automatically be executed when loading the Emulator, then
you must install the driver to interface with your hardware adapter. The
communications driver should be installed in the AUTOEXEC.BAT file or
equivalent file before Windows is loaded.

+
 

Add to your AUTOEXEC.BAT file the following command statement:
f:\subdirectory\COMMDVR.EXE

Where f:\subdirectory\ is replaced with the drive and subdirectory where
FORVUS Emulator is installed.

Removing the Communications Driver

To remove the communications driver from memory, follow the steps below:
• Switch to the drive and subdirectory where the emulator is installed.

(Usually C:\FORVUS)
• Type COMMDVR /X and press the Enter key.
• You will be notified of the removal of the communications driver.

+ The driver cannot be removed without first removing other
resident programs that may have been loaded after the
communications driver was loaded.

It is important that the FORVUS Emulator communications
driver is installed after the network driver (IPX/SPX, LLC. or
TCP/IP Stack) is installed
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Reducing DOS memory requirements

The communications driver is able to load into the Upper Memory Area
maintained by DOS. This reduces the amount of required DOS conventional
memory (space below 640K). This feature is available with DOS Version 5
or greater.

When using DOS Version 6, it is recommended that the user run the DOS
MemMaker program after installing the emulator. MemMaker will find the
best memory location for loading the communications driver in high mem-
ory.

If you do not have enough Upper Memory available to load the entire driver,
the communications driver will load smaller data areas into your Upper
Memory to maximize the use of your system unit’s memory.

Manual installation

To install the driver in Upper Memory, follow the steps below:
• Switch to the drive and subdirectory where the emulator is installed.

(Usually C:\FORVUS)
• Type COMMDVR /U and press the Enter key.
• You will be notified of the installation of the communications driver.

Automatic installation

To install the driver in Upper Memory using the AUTOEXEC.BAT method,
follow the steps below:

• Switch to the drive and subdirectory where the AUTOEXEC.BAT file
is located. 

• Using an ASCII text editor, open the AUTOEXEC.BAT file.
• Modify the line that contains f:\path\COMMDVR and add the /U

command.
• Close the AUTOEXEC.BAT file and reboot your system.
• The communications driver will now be installed in the Upper Memory

area.
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Keyboard Layouts

This appendix describes US keyboard layouts supported by the emulation
program. These keyboards layouts may be referred to during installation or
customization procedures. Refer to page 14, "Configuring the Keyboard" to
modify these layouts for your personal preference.
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US1.KBF 83/84 key - IBM Layout
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US1.KBF 101 key - IBM Layout
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US2.KBF 83/84 key - Attachmate Layout
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US2.KBF 101 key - Attachmate Layout
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US3.KBF 83/84 key - IRMA E78 Layout
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US3.KBF 101 key - IRMA E78 Layout
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CHKLNK
CHKLNK is a problem isolation program that can be used with the FORVUS
Emulator to test the LANSYS connection.

The FORVUS Emulator may fail to establish or may lose the link with the
Memorex Telex 1174 controller. If the line activity indicator does not
function, or if the system status symbol is not displayed on the status line
shortly after you enter the DOS command to execute the program, it is likely
that a problem exists in the LAN, the PC LAN interface, or in the controller.
To isolate the problem, run the CHKLNK program that is supplied on the
FORVUS Emulator diskette. CHKLNK tests the resident LAN SUPPORT
PROGRAM and uses it to find and test the path to the 1174 controller.

To run CHKLNK, type CHKLNK at the DOS prompt.

If CHKLNK is successful in communication the following is displayed:

   PC=xxxxxxxxxxxx  (the PC’s node address on the LAN)
     1174=xxxxxxxxxxxx  (the 1174’s node address on the LAN)
     CHKLNK OK! 

The FORVUS Emulator requires the IBM LAN SUPPORT PROGRAM
(LSP) or its equivalent to be resident. This is installed through DEVICE=
commands in the CONFIG.SYS file. It provides an IEEE 802.2 LLC interface
for the FORVUS Emulator. Commands to control communications through
the LAN are given to this resident program, and the results are returned to
the emulator through a hexadecimal return code. These codes are defined
in the IBM PC LAN Technical Reference. If CHKLNK is not successful, a
message describing the failure is displayed. Possible error messages from
CHKLNK are:

NO LAN SUPPORT PROGRAM
The IBM LAN SUPPORT PROGRAM or its equivalent is not installed. This
must be installed through DEVICE= command in CONFIG.SYS.

NO SAP AVAILABLE
There was no Service Access Point (SAP) available for the FORVUS Emu-
lator to use. The number of SAP’s must be increased, or NETBIOS must be
instructed to reserve an extra SAP. This is done with parameters on the LSP
command lines in CONFIG.SYS. See the documentation provided with the
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LAN SUPPORT PROGRAM or your network adapter.

NO STATION AVAILABLE.
There was no station available for the FORVUS Emulator to use. The
number of stations must be increased, or NETBIOS must be instructed to
reserve an extra station. This is done with parameters on the LSP command
lines in CONFIG.SYS. See the documentation provided with the LAN
SUPPORT PROGRAM or your network adapter.

OPEN ADAPTER FAILED. LSP RETURN CODE=xxxx.
The LAN adapter was not open, and the LSP command to open it failed.
This is usually cased by a hardware problem or a conflicting node address
on the LAN. All nodes on the LAN must have a unique address. If a node
tries to enter the LAN with an address already in use, it automatically
removes itself. The following is a list of some hardware problems:

• No adapter cable attached to the PC.
• Device drivers for the LAN adapter not installed.
• Hardware interrupt conflicts within the PC.
• Hardware addressing conflicts within the PC.

OPEN SAP FAILED. LSP RETURN CODE=xxxx.
The usual reasons for OPEN SAP to fail are if there are no SAP’s available
or if SAP 98 is already in use. (xxxx-0043)

RECEIVE COMMAND TO THE SAP FAILED. LSP RETURN CODE-xxxx.
This should never fail. Make a note of the return code, and contact your
support personnel.

NO 1174 RESPONDED TO THIS STATION.
Either there is no 1174 that can be reached through the LAN, or there is an
1174 on the LAN supporting LAN terminals, but it is not configured to accept
communications from this node. Compare the node address (displayed by
CHKLNK) with the addresses configured in the 1174 for LAN TERMINALS.

INCOMPATIBLE REVISIONS LEVELS.
The microcode in the 1174 is not compatible with this level of the FORVUS
Emulator.

TRANSMIT XID FRAME FAILED.  LSP RETURN CODE=xxxx.
This should never fail. Make a note of the return code, and contact your
support personnel.
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HLLAPI
Introduction
High-Level Language Application Program Interface (HLLAPI) works with
the FORVUS Emulator and provides a programmatic interface between a
host computer and a PC application program. The emulator establishes
communications between your PC and the host and allows your PC to appear
to both you and the host to be a 3270 display station. HLLAPI then provides
the interface between the emulator and the application.

The application communicates with HLLAPI, making the application inde-
pendent of the PC hardware and communications protocol used. This also
frees the programmer from the need to understand the operational details
of the hardware and protocol. The application access via function calls to
routines and information is passed through the function call parameters.

IBM HLLAPI Compatibility

The FORVUS EHLLAPI is compatible with IBM’s High Level Language
Application Program Interface (EHLLAPI Version 2.0 Windows). Applica-
tions written for standard IBM EHLLAPI Version 2.0 for Windows (not
modified be the user to support extended functions) should run under
EHLLAPI with no modifications or relink required.

The HLLAPI filename is PCSHLL.DLL

EHLLAPI used the following conventions to provide extended functionality
and programming flexibility while maintaining HLLAPI compatibility:

• EHLLAPI supports all HLLAPI functions except the following:
- Keystroke intercept functions 50-53
- Set cursor position function 40 in CUT mode.

• EHLLAPI supports all HLLAPI options and features for each function.
All parameters have the same meaning as in HLLAPI.

• EHLLAPI supports all HLLAPI return codes except those which apply
specifically to the IBM 3270PC.

• EHLLAPI supports all 3270 keys supported by HLLAPI except those
which are specific to the IBM 3270 PC keyboard (COPY,FINISH, HELP,
JUMP, MAGNIFY). EHLLAPI also supports additional 3270 keys.

Applications using 3270 PC specific keystrokes may have some limitations
because of the hardware limitations listed above.
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Running EHLLAPI

EHLLAPI is available whenever a Windows emulator session is running.
The emulator session can be minimized to an icon, and EHLLAPI will still
be available.
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D
defective items  74
device driver

installing  95, 105, 107
memory requirements  96
removing  95

disk error messages  89
displaying the menu bar  40

document  69
dualcase  45

E
edit  41
edit command  41

copy  42
cut  42
paste  42
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undo cut  41

EHLLAPI  107
error messages  89
exit  41
extended attributes  51
extended select  68
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file command  40

exit  41
file transfer  41
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local print  41
printer setup  41
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file transfer  41, 75
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options  77
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help command  59
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hiding the menu bar  40
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hotspot  45, 61
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copy and enter  61
defined names  61
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label  13

insert  68
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keyboard
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operation  39
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types  16
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keypad
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width  20
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language

setup  8
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local print  41, 60

M
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mode status  68
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operating system
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operation  37
options  7
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files  19
sample  62

print options  12
ASCII Transparency  12
default 17 CPI  12
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suppress null lines  12

print trim  60
printer
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lines/page  11
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quality  12
setup  41
type  10

printer status  68
problem determination  71, 105
product support  4, 74

110     Index



Q
quit

See exit
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README.DOC  3
record/play command  56

begin recording  57
cancel  58
end recording  57
pause  57
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resume  57
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file transfer  75
system  2

rule  45, 60
color  52
movable  60
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screen printing  60

partial ...  60
select all  42
session

configuration  8
icon  13

session options  10
setup  5, 43
setup command  43

color  50
font  54
HAP control  55
printer  48
reset logical unit  56
screen/cursor  44
session control  53
sound  46

shortcut keys  40
software

installation  5
startup

error messages  91
status row  63

comm reminders  67
do-not-enter  65
entry assist  69

error status  69
printer status  68
record/play status  70
shift status  68
system status  64

support  74
suppress line feed  11
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undo cut  41
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